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ABOUT THE DOCUMENTATION 
Documentation consists of the following manuals and help systems. These manuals are 
delivered as PDF files that are stored in the documentation\language code\reference 
folder where the Developer is installed.  

• Installation & Administration: provides instructions for installing the Developer 
in a single-user or multi-user environment as well as information on how to add 
and manage users and content in a multi-user installation. An Administration help 
system also appears in the Developer for authors configured as administrators. 
This manual also provides instructions for installing and configuring Usage 
Tracking. 

• Content Development: provides information on how to create, maintain, and 
publish content using the Developer. The content of this manual also appears in 
the Developer help system. 

• Content Deployment: provides information on how to deploy content to your 
audience. 

• Content Player: provides instructions on how to view content using the Player. 
The content of this manual also appears in the Player help system. 

• Usage Tracking Administration & Reporting: provides instructions on how to 
manage users and usage tracking reports. 

• In-Application Support Guide: provides information on how implement content-
sensitive, in-application support for enterprise applications using Player content.  

• Upgrade: provides information on how to upgrade from a previous version to the 
current version. 

 

 





 Copyright © 1998, 2010, Oracle. All rights reserved. v 

CONTENTS 

1. In-Application Support Overview............................................1-1 
Plan for Deploying In-Application Support ............................................1-1 

Target Application Configuration and Content Creation........................1-2 

2. Implement In-Application Support .........................................2-3 
Obtain Content ................................................................................2-4 
Configure Content ............................................................................2-4 

Use the IAS Configuration Utility......................................................2-4 
SmartHelp....................................................................................2-6 
Target Application-Specific Configuration Settings ..............................2-7 
Oracle E-Business Suite Special Options............................................2-9 
SAP GUI for HTML and Windows Special Options ................................2-9 
SAP NetWeaver Portal Options.......................................................2-10 

Deploy the Content on a Web Server.................................................2-10 
Integrate Help in Target Applications................................................. 2-11 

Agile CNM ..................................................................................2-11 
Agile PLM ...................................................................................2-11 
CA Clarity PPM ............................................................................2-11 
JD Edwards EnterpriseOne ............................................................2-12 
JD Edwards World........................................................................2-12 
Microsoft Dynamics CRM...............................................................2-13 
Oracle E-Business Suite................................................................2-13 
PeopleSoft Enterprise...................................................................2-16 
SAP Portal ..................................................................................2-19 
Siebel CRM (On Premise)..............................................................2-20 

Install SmartHelp for Browser-based Applications................................ 2-21 
Install SmartHelp for Microsoft Internet Explorer..............................2-21 
Install SmartHelp for Mozilla FireFox ..............................................2-22 
Change the Name of SmartHelp.....................................................2-23 

 
 





 Copyright © 1998, 2010, Oracle. All rights reserved. 1-1 

The Player deployment format that is published from the Developer is not only useful in 
various training and educational initiatives; it is also designed to provide in-application 
support for end users.  

There are specific add-ons and instructions for certain major enterprise applications to 
accommodate context-sensitive in-application support; these applications are referred to 
as target applications throughout this document. Content for target applications can 
generally be deployed using one or both of the following methods, depending on the target 
application: 

• Help Integration - This method allows users to invoke context-sensitive in-application 
support content using the existing target application Help menu or Help link. 
 

• SmartHelp - This is a toolbar button for browsers that end users may use to access 
context-sensitive in-application support content. 

The mechanism for context-sensitivity used for target applications is known as 
ExactMatch. This technique allows the Player to display a list of content that is related to 
the end user's activity in the application. The relevancy of the content list is determined 
based on content items that contain exactly the same context information as recorded 
during content creation in the Developer. 

The mechanism for context-sensitivity for browser-based non-target applications is known 
as SmartMatch. This technique uses statistical analysis to rank the most probable content 
items and generates a list of relevant content. This allows you to use the SmartHelp 
toolbar button to deploy context-sensitive in-application support for any browser-based 
application. 

Finally, content created for non-target applications prior to the introduction of SmartMatch 
technology may still be deployed using the SmartHelp toolbar button for the browser 
without context-sensitivity. In this case, the outline displays all of the content items; 
however, the user may find the appropriate items using the Search feature or by browsing 
the content outline.  

See the Content Deployment manual for more information about deploying Player content. 

Plan for Deploying In-Application Support 
Once you decide to deploy content for in-application support, some of the fundamental 
questions that need to be addressed are: 

• What deployment mechanism is most appropriate for your application, Help Integration 
with a target application or SmartHelp-based deployment? 
 

• Who needs to be involved, what needs to be done, and when does it have to happen?  

Understanding the answers to these questions will give you the information you need to 
implement help integration and context-sensitive help successfully.  

These are the tasks which need to be completed to successfully deploy in-application 
support. 

1. In-Application Support Overview 
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Content Author 

• Create content in the Developer - While ExactMatch information for target applications 
and SmartMatch information for browser-based non-target applications will be 
automatically captured, it is recommended that you validate that context is being 
captured. 
 

• Publish the content 
 

• Give the published content to the web server administrator 

Web Server Administrator   

• Deploy the published content to a web server 
  

• Provide the URL for the content to the application administrator  

Application Administrator   

• Perform the configuration steps detailed in this guide for each application 
   

• Receive the content URL from the web server administrator 
    

• Perform help integration steps for URL configuration, if applicable 

Test User   

• Verify the published content appears from the application using the Help Menu 
Integration option or the SmartHelp button, as deployed 
 

• If you are deploying context-sensitive help, the test user should coordinate with the 
content developer to note which parts of the application were used to create content 
and then verify that the content launches with an appropriate list of relevant topics.  

Target Application Configuration and Content Creation 

For most target applications, application configuration can occur after and independently of 
content creation. There are two exceptions:  

• Oracle E-Business Suite: It requires library files to be installed on the application server 
(applcore forms server) before recording content. See Implement Context-Sensitive 
Help Integration in the Oracle E-Business Suite section later in this manual for more 
information on installing library files for Oracle E-Business Suite. 
Note: Oracle E-Business Suite 12.1.2 no longer needs the library files; however, you 
should add a profile in the System Profile form. 
  

• PeopleSoft Enterprise: It is recommended that PeopleBooks is installed and configured 
before starting to record content. 

If you want to deploy context-sensitive help, always check that context is being captured while 
recording. See Context Recognition in the Recorder in the Record and Edit Topic Content 
chapter of the Content Development manual for more information on capturing context while 
recording.  
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End users access in-application support in one of two ways. The first is via a help link, button, 
or menu item in the recorded target application. This option is called help integration and 
requires an application administrator to make minor configuration changes in the target 
application to enable the Player context-sensitive help. The second option, called SmartHelp, is 
to install a toolbar button in a browser in which a user launches the target application. This is 
installed as a browser add-on and may require the help and approval of your Information 
Technology resources.  
 
These are the steps for implementing in-application support. You may or may not need to 
perform all of them, depending on the target application that your audience will be using.  

• Obtain content that has been created and published in the Developer 
    

• Configure content with the In-Application Support (IAS) Configuration Utility 
    

• Deploy content on a server 
   

• Configure the target application for help integration (if applicable for the target  
application your audience will be using) 
   

• Install SmartHelp, if it is applicable for the application your audience will be using  

Applications supported by:   
  
SmartHelp only   
CA Clarity PPM (version 12)   
CA Service Desk  
Oracle (Siebel) CRM On Demand  
Oracle (Hyperion) EPM  
Oracle Transportation Management  
Other Browser-based applications (if the browser toolbar is available)  
  
Help Integration only   
Agile PLM  
JD Edwards World  
Microsoft Dynamics CRM (version 3)  
SAP GUI for Windows  
  
Either SmartHelp or Help Integration   
Agile CNM 
Clarity PPM (version 8)  
JD Edwards EnterpriseOne  
Microsoft Dynamics CRM (version 4)  
Oracle E-Business Suite (SmartHelp not supported for Oracle Java Forms)  
PeopleSoft Enterprise  
SAP GUI for HTML  
SAP NetWeaver Portal  
Siebel CRM (On Premise)  
  
Refer to the following information for the general steps to implement SmartHelp or help 
integration.    
  

2. Implement In-Application Support 
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Implement SmartHelp    

• Obtain content in the form of a Player package that an author created and published 
from the Developer. 
   

• Configure content using the IAS Configuration Utility to set options for SmartHelp. See 
Configure SmartHelp. 
   

• Deploy content to a web server. 
   

• Install SmartHelp by deploying the link for installing SmartHelp to your end users. See 
Use SmartHelp for Browser-based Applications. 

Implement Help Integration 

• Obtain content in the form of a Player package that an author created and published 
from the Developer. 
   

• Configure content using the IAS Configuration Utility to set options for help integration. 
See Application-Specific Configuration Settings. 
   

• Deploy content to a content on a Web server. 
   

• Integrate Help into the target application by adjusting settings in the target application 
to launch the content. See the appropriate section for your application in Integrate 
Help for Target Applications. 

Details about each step are in the following sections.  

Obtain Content 
Whether you are implementing help integration or SmartHelp, you need content that has been 
published to the Player format from the Developer. You can create and publish this content 
yourself, or you can use purchased content from your enterprise application vendor.     

• Create and publish content – An author will use the Developer to create and record 
content, and then publish it to the Player format. This results in a folder structure 
containing a subfolder with the name PlayerPackage. It is this PlayerPackage folder 
that you need.  
   

• Purchase content – Some enterprise application vendors sell pre-packaged content for 
their applications to help customers understand application functionality and 
configuration options. If you purchase content, you should receive a complete 
PlayerPackage.  

Configure Content 
Whether you are configuring content for SmartHelp or help integration or both, there are 
options you can set for context sensitivity and launch behavior.  

The published content contains the IAS Configuration Utility to help you make the appropriate 
settings for your needs. 

Use the IAS Configuration Utility 
As you use the IAS Configuration Utility to change and save settings, it creates a configuration 
file, writes the necessary lines of code, and saves it to the appropriate location.  
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If a target application supports help integration, there is a link specifically for that target 
application on the main page of the IAS Configuration Utility. There is also a link for SmartHelp 
options at the bottom of the page. The options on the SmartHelp page apply to all target 
applications that support SmartHelp, plus all browser-based applications since SmartHelp can 
be deployed for any application that runs in a browser, except one that hide the browser 
toolbar.  
  
As you make changes to the configuration settings and save them, the Activity column on the 
right in the main page displays information about the date and time the change was made, and 
the name of the person who made them. You can add a name in the My name is field at the 
top of the page. If you add your name, or pick your name from the dropdown list, it appears in 
the Activity column.  
  

To launch the IAS Configuration Utility (locally):  

1. Navigate to the folder containing the Player package. 
2. If you use Internet Explorer, launch the inappconfig.cmd file. 

   
or 
   
If you use Mozilla Firefox, launch the inappconfig_ff.cmd file. 

Use Notes  

You can add a note to each option as well as to the configuration file as a whole. These notes 
are saved as comments in the configuration file. You can use notes to add information about 
why a change to the configuration was made, and so on.  
  

To add, edit, or delete a note:  

1. Launch the Configuration Utility and open a page for an application. 
2. To add a note for a field, click the Add Note button next to that field. 

   
or 
   
To add a note for the configuration file as a whole, click the Add Notes button at the 
top of the page. 
  

3. Enter the text of the note and click Ok. 
4. To edit a note, click in the text box for the note, make your changes, and click Ok. 
5. To delete a note, click the Delete button on the note. 

Save the Configuration File  
If you are launching Configuration Utility from the command file, the configuration file 
(odcustomurl.js) is saved directly to the appropriate folder within the content folder on the 
local drive.  
  
Note: If you are not sure that the configuration file was saved correctly, you can retry the 
save. The Save Configuration page appears, displaying the location where the file was saved. If 
necessary, you can save the file manually, and then use the Check option to verify that the file 
is in the correct location.  
  

To save the configuration file locally:  

1. Click Save. The Check Configuration page appears displaying the name of the file and 
the location where it was saved. 
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Revert Settings  
At the bottom of each page of configuration settings, there is a Revert button. This option 
changes all of the settings on the page back to what they were the last time that the 
configuration was saved.  
  

To revert the settings:  

1. Click Revert. 

Reset to Defaults  
You can also set options back to the original settings, individually or for all options on a page. 
When you make a change to an option, a Reset button appears next to that option. You can 
use this button to set the option back to the default. In addition, there is a Reset to Defaults 
button at the bottom of each page, which sets all the options on the page back to original 
defaults.  
  

To reset to defaults:  

1. To reset a field to the default, click the Reset button next to the field. 
   
or 
   
To reset all of the fields on a page to the default, click the Reset to Defaults button at 
the bottom of the page. 

SmartHelp 
When you record browser-based application content, the content is automatically ready for 
deployment with the SmartHelp toolbar button. You can host the published content on a web 
server and install SmartHelp from the hosted content location.  
  
Other than deploying SmartHelp to end users, there is no content configuration required. There 
are options, however, if you want to deploy context-sensitive help or disable the SmartMatch 
capability. It is also possible to deploy the SmartHelp button from one web server location 
while hosting the content in another web server location.  
  
Note: If you have content created in different versions of the Developer, SmartHelp should be 
installed and configured from the latest version. An older version of SmartHelp must not point 
to content from a newer version.  
  
There is a page in the Configuration Utility that contains all of the SmartHelp Options, which 
include the following:  
  
ExactMatch Application Scripts:  This is a list of URLs to the application script folders in the 
published content that enable ExactMatch context-sensitivity with SmartHelp. ExactMatch is 
available for the target applications listed below. The URL will end with the text shown in the 
Link text below for each application. Do not include /hemi in the URL. For example, 
http://server/contentfolder/oracle.  
  
Note: A number in the link name does not imply the version of the target application.  
 
        Target Application /Link 
        Agile CNM /agliecnm 
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SmartMatch Content URL:  If SmartMatch content is deployed to a different location, this 
URL points to the /stdhtml folder within the content. For example, 
http://server/contentfolder/stdhtml 
       
No-Match Content URL: If no matching content is found for the ExactMatch applications or 
SmartMatch is not available, this URL is used to launch content without context sensitivity. For 
example, http://server/content/index.html   
  

To configure SmartHelp options:  

1. Launch the Configuration Utility. 
2. Click the SmartHelp link. 
3. Enter the URL to the application script folder. 
4. If you have more than one application for which you want to enable SmartHelp, click 

the New Row icon and enter another URL. 
5. Enter a default content URL, if desired. 
6. If the content is located in a separate location than the scripts, enter the URL to the 

content in the SmartMatch URL field. 
7. Click Save. 

Target Application-Specific Configuration Settings 
For target applications that support help integration, there are three possible feature 
configurations: Gateway, Multi-Language Content, and Advanced Options. Certain target 
applications have additional special options.  
  
Configure Gateway  

The options in this feature allow you to configure a gateway page that launches when a user 
clicks the Help link. You can configure the gateway page to give the user access to additional 
resources, such as the original help for the target application, additional Player packages, or a 
URL to another web site.   

  
The gateway page has two options, tabs and links. The tabs appear across the top of the page, 
and you can specify the text for the tab as well as the URL to the content. The links appear in a 
menu on the last tab, and you can specify the link text as well as the target of the link. In most 
cases, it is your choice whether to use a tab or a link. There are a few exceptions. Some web 
pages cannot be embedded in a tab, so you must use a link to launch them. An entry for the 
target application help may appear in either the Tab or the Link Type list, depending on 
whether it can be embedded. In addition, the default player content (see Default Content URL 
below) will always appear as the first tab.  

• Default Player Tab Text: The default Player is the one you launched the configuration 
utility from. This is the Player that launches if you do not configure the gateway page. 
In addition, if you configure any kind of content segmentation, such as multi-language 
support, it only applies to the default Player. With this option, you can determine the 
name on the tab for the default Player. 
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• Tabs: There are three options in the Tabs section.  
 
The first option is the Type list, which has three choices. Use the Player with Context 
Sensitivity to launch a Player with an outline filtered to the topics appropriate to the 
location in the target application from which it is launched. Use the Player option to 
launch any Player content. These two Player options are not subject to the language or 
other content segmentation that you may configure. Use the URL option to launch a 
website or page on the Internet or intranet. Depending on the target application you 
are configuring, an option may also appear to launch the target application help.  
Note: You should verify that there is valid content at the specified URL. 
 
The second option is the Tab Text field. This allows you to specify the text you want to 
appear on the tab. 
 
The third option is the URL field. Enter the URL to the root of the PlayerPackage folder 
(do not enter a specific page, such as index.html) or to the webpage. 
 
In addition, you can use the + and X icons to add and delete rows, and the up and 
down arrows to change the order of the tabs. You cannot change the order of the 
default player tab; it will always be the left most tab. 
   

• Remember Active Tab: If this option is Yes, a cookie is placed on the user's system so 
that the gateway page launches with the tab that was active when the user last 
accessed it. 
   

• Link Menu Text: This option allows you to change the name of the link menu text that 
appears on the gateway page. 
   

• Links: There are three options in the Links section.  
 
The first option is the Type list, which has three choices. Use the Player with Context 
Sensitivity to launch a Player with an outline filtered to the topics appropriate to the 
location in the target application from which it is launched. Use the Player option to 
launch any Player content. These two Player options are not subject to the language or 
other content segmentation that you may configure. Use the URL option to launch a 
website or page on the Internet or intranet. Depending on the target application you 
are configuring, an option may also appear to launch the target application help. 
 
The second option is the Link Text field. This allows you to specify the text you want 
for the item on the link menu. 
 
The third option is the URL field. Enter the URL to the root of the PlayerPackage folder 
(do not enter a specific page, such as index.html) or to the webpage. 
 
In addition, you can use the + and X icons to add and delete rows, and the up and 
down arrows to change the order of the tabs. You cannot change the order of the 
default player tab; it will always be the left most tab. 

Configure Multi-Language Content  

The options in this feature allow you to configure the help to launch the appropriate content if 
you have developed content in multiple languages. This feature is only available for certain 
target applications. 

Note: The Default Player tab in a tabbed gateway configuration honors language or any other 
segmentation. 



 Copyright © 1998, 2010, Oracle. All rights reserved. 2-9 

• Content URLs by Language:  This option has two fields, Language and Content URL. 
Use the Language list to select a language, and then enter the URL to the content 
developed in that language in the Content URL field. You can add new rows as 
necessary to support all available languages. 
   

• Default Content URL:  This is a URL to the content to be launched if the language is not 
defined in the Content URLs by Language list. For example, if you have defined English, 
Spanish, French, and German, and someone logs on in Italian, you can specify that the 
English content should be launched. The Player content being configured, i.e., the one 
from which you launched the Configuration Utility, will be used if there is no language 
match. 

Configure Advanced Options  
The options in this feature allow you to control how the outline appears when the content is 
launched, and point to the content if the scripts folder is moved.  

• Outline Display:  If you have configured the content to launch with context-sensitivity, 
then the outline will only contain the items which are related to the task the user is 
performing in the target application. This is called applicable content, and it is the 
default setting. If you want the entire content outline to display instead, you can 
change this option to show all content. 
   

• Special Content Location:  If the configuration file folders, [application name]/hemi and 
/stdhemi are copied from their default location from within the published content, you 
must enter a URL in this field which points to the content location. This option should 
only be used on the advice of Technical Support. 

Special Options  
Certain target applications have special options. Most of these appear under Advanced options 
as necessary. If there are special options for the target application you are configuring, see the 
following sections for more information.  
 

To configure application-specific options:  

1. Launch the IAS Configuration Utility.  
2. Click the target application link that you want to configure.  
3. Change settings as appropriate.  
4. Save the configuration.  

Oracle E-Business Suite Special Options 
The following options are available for Oracle E-Business Suite:   

• Oracle Version:  Specify 11i or R12. The Help URL is different for the two versions, and 
choosing the version in this option displays the correct example for the Help URL field. 
Note that 11i and R12 use different language codes. 
   

• Show Context Recapture Page:  Do not change this option unless advised to do so by 
Customer Support. 

SAP GUI for HTML and Windows Special Options 
The following options are available for SAP GUI:  
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Configure Content Segmentation and Multiple Languages 

In SAP, you can segment the content by GUI Type and SAP User Parameter in addition to 
language.  

• Segment Content By: This option allows you to choose the type of segmentation. When 
you change this option, the fields in the Content URLs by Segment adjust accordingly. 
  

• GUI Type: If you choose to segment content by GUI type, this field appears, allowing 
you to specify the GUI for each content URL. 
  

• SAP Param: If you choose to segment content by SAP User Parameter, this field 
appears, allowing you to enter the value of the SAP user data for each content URL.  
Note: To use this parameter for segmentation, the parameter /GKOD/Y_ROLE must be 
created in each SAP user's Master Record (transaction SU01). The values in the Master 
Records and the values in the SAP Param field must match for the appropriate content 
to be returned. 

Additional Options 

• Content Priority: When using in-application support with SAP GUI for HTML embedded 
in SAP Enterprise Portal, normally both SAP GUI and Portal topics are applicable. 
Enable this option in either SAP Business Suite or SAP Enterprise Portal configuration to 
match only content for that application when both applications are found. 
  

• GUI 6.40 patch 8: Enable this option only if you have recorded content with this SAP 
patch and have context sensitivity issues. 
  

• Partial Context: When you record content, context IDs are captured, which allows for 
context sensitivity. In SAP, these context IDs can consist of up to three components: 
the transaction code (T), the program name (P), and the screen number (S). You can 
enter the appropriate value to control which of these components are used to find 
applicable content. The default is to use all three components. 
Note: This option is only required if you have context sensitivity issues. Contact 
Technical Support before using it. 
  

• Show Context Recapture Page: Do not change this option unless advised to do so by 
Customer Support. 

SAP NetWeaver Portal Options 
The following options are available for SAP Portal: 

• Content Priority: If you are using in-application support for SAP GUI for HTML 
embedded in SAP Enterprise Portal, normally both SAP GUI and SAP Portal topics are 
applicable. Enable this option in either SAP Business Suite or SAP Enterprise Portal 
configuration to match only content for that application when both applications are 
found. 

Deploy the Content on a Web Server 
Once you have published and configured your content, copy all the content and place it in a 
location that is accessible by HTTP or HTTPS protocols. If you are implementing SmartHelp, 
you should give this URL to your end users so that they can install SmartHelp. If you are 
implementing help integration, you must use this URL when you configure the target 
application.  
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Integrate Help in Target Applications 
If help integration is available for a target application, there is usually some configuration that 
must be done on the application server. This section outlines the configuration for each target 
application. 

Agile CNM 
Agile CNM can be configured to launch context-sensitive help through the Help button. When 
the user clicks the Help button, the Player help launches directly or a gateway page appears 
allowing the user to choose between the Player help and the Agile CNM help.  
  
A System Administrator can configure the Agile CNM application to launch the context-sensitive 
Player help from the Administration link inside the application.  
  

To configure Agile PLM:  

1. Log in to the Agile CNM application.  
2. Click the Administration link. 
3. Click the System Settings link. 
4. Click in the Online Help URL field. 
5. Change the URL to point to the agilecnm_gateway.html file inside the Player Package. 

Example: http://<server>/<directory>/agilecnm/hemi/agilecnm_gateway.html 
6. Click Save. 

Agile PLM 
Agile PLM can be configured to launch context-sensitive help through the Help button. When 
the user clicks the Help button, the Player help launches directly or a gateway page appears 
allowing the user to choose between the Player help and the Agile PLM help.   
   
You configure the Agile PLM application to launch the context-sensitive Player help directly 
from the Help button by using the Java client interface for administration.  
  

To configure Agile PLM:  

1. Log in to the Agile Java client application.  
2. Click the Admin tab.  
3. Expand the Server Settings item in the tree.  
4. Double-click the Locations item in the tree.  
5. Click the Online Help Manuals URL field.  
6. Enter the server and virtual directory where the published Player content is located, for 

example: http://<server_name>/<folder_name>/agile/hemi/agile_gateway.html".  
7. Click the Close button.  
8. Click the Yes button.  

CA Clarity PPM 
Configure the Help Link Redirector for Clarity 8  
For the context-sensitive content to be launched from Clarity, the pre-existing Help launch file 
(wwhelp.htm) should be replaced for each language.  
  

To configure the Help Link Redriector:  

1. Rename the existing wwhelp.htm file on the Clarity server (per language) to 
wwhelp1.htm. The default path for this file for the English language Help is: 
http://<clarity server>/niku/help/en/wwhelp/wwhimpl/js/html/wwhelp.htm 
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2. Place the contents of the clarity\hemi\wwhelp\ directory in the same location where 
you renamed the existing wwhelp.htm file 

3. Open the capawwhelp.js file to enter the value for OD_GATEWAYURL. The URL value 
for OD_GATEWAYURL should point to the location where the content gateway file is 
deployed. It should be a fully qualified URL similar to:  
http://<content server>/<content>/clarity/hemi/claritygateway.html. 

JD Edwards EnterpriseOne 
In the P98MOQUE file, update the Helps path to point to the pste1_gateway.html file in the 
/psentone/hemi folder. This path should be a URL path based on your virtual directory 
setup. 
    
For example: 
http://<server>/<dir>/psentone/hemi/pste1_gateway.html   
  
It is a good idea to make a note of the original PeopleBooks help URL in case you want to use it 
later. 
 
Note: While setting up the Media Object Queues you may use Help Content as the Queue 
name and point to pste1_gateway.html file under ..\psentone\hemi in the published content 
folder as the On-Line and Off-Line Queue paths. 

JD Edwards World 
The instructions that follow are for the JWalk Java client interface. A button to launch Player 
content appears on the program menus; no configuration is necessary for this button to 
appear. However, it must be configured to point to the Player help content through entries in 
two text files.  
 
To launch the context-sensitive help content, the JD Edwards World Web Enablement 
administrator needs to set entries appropriately in the WV9100.JVM and DYNBLD9100.JVM text 
files. These files are located within the Deployment area of the JWalk server or client. 

• For the iSeries-i5 Installation: 
www/<HTTP server>, such as apachedft/htdocs/JWALK/JWALKAPP/A9100APP  
  

• For the Windows NT-2000-2003 Server Installation: 
C:\Inetpub\wwwroot\JWALKAPP\A9100APP or 
C:\Program Files\Apache Software Foundation\Apache2.2\htdocs\JWALKAPP\A9100APP 

The Text File entries to be updated are: 

• UPKVIEWI - Set this to Y to display the Context aware icon on the program menus. 
  

• UPKVIEWH - Set this to Y to display the View Content Option from the Help Drop Down 
menu. 
  

• UPKHELP - This displays text when hovering over the Context aware icon. 
  

• UPKHELPOPT - This displays text for the option on the Help Drop Down menu. 
  

• UPKPath - This should be set to the path of the UPK server. For example: 
http://<server>/<virtual directory>/jdewalk/hemi/jdewalk_gateway.html_?CTXEX= 
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If you place the help content on the Windows server supporting the JWalk client interface, no 
additional configuration is necessary. If the help content is on a non-Windows server, you need 
to configure the odcustomurl.js file. 

Microsoft Dynamics CRM 
For the context-sensitive content to be launched from Microsoft Dynamics CRM, the pre-
existing Help launch file (default.aspx) should be replaced for each language.  
  

To configure Microsoft Dynamics CRM:   

1. Rename the existing default.aspx file on the Microsoft Dynamics CRM server (per 
language) to default1.aspx. The default path for this file for this file is: 
http://<dynamics_server>/crmweb/help/default1.aspx 
  

2. Place the contents (files) from the mscrm3\hemi\help\ directory in the same location 
where you renamed the existing default.aspx file. 
  

3. Open the mscrmhelp.js file to enter the value for OD_GATEWAYURL. The URL value for 
OD_GATEWAYURL should point to the location where the content gateway file is 
deployed. It should be a fully qualified URL similar to:  
http://<content server>/<content>/mscrm3/hemi/mscrm_gateway.html 

Microsoft Dynamics CRM users will now be able to launch context-sensitive content from the 
Help menu with the Help on This Page menu item as well as the Help toolbar button. 

Oracle E-Business Suite 
To implement Help Integration for Oracle E-Business Suite, you must install and compile two 
library files that are delivered with the Developer installation. To complete the integration, 
modify the HELP_WEB_AGENT profile on the Oracle server to point to the Player content. This 
causes the Player interface to launch directly from the Oracle Help menu.  
 

Implement Context-Sensitive Help Integration  
If you want to implement context-sensitive help for Oracle E-Business Suite applications, the 
correct Context IDs of the objects in Oracle must be captured while the content is recorded. To 
enable this in Oracle E-Business Suite 12.1.1 or earlier, you must deploy or modify the custom 
library (CUSTOM.pll) on the Oracle server you will use to record the content. This must be done 
before you begin to record content. To enable this in Oracle E-Business Suite 12.1.2, you can 
add an entry in the System Profile form. 

  
Enable Context Recognition in Oracle E-Business Suite 12.1.1 or Earlier  
To enable context recognition, you must either deploy a custom library or modify an existing 
one, and then modify the HELP_WEB_AGENT profile. The custom library is required for 
recording content only. It is not necessary for deployment of context-sensitive content from 
Oracle E-Business-Suite. If you use the different systems for development (content creation) 
and production (deployment), then the custom library configuration is not necessary in the 
production environment. If you use the same system for development and production, then 
custom library only needs to be installed while the content is being recorded. 
 
Check Existing Custom Library Configuration 
The .pll delivered with the Developer is written with SPECIAL7 as the default value. This default 
value is a suggestion. You can use anything between 1 and 15. If you have not created any 
Oracle specific applications that use the SPECIAL event, you can use the default. If you have 
created Oracle-specific applications that do use the SPECIAL event, the value of 7 may be 
taken, and you need to find another suitable unused value between 1and 15.  
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You can use the following command lines to find an unused value instead of editing and 
recompiling the custom.pll file repeatedly: 
 
cd $AU_TOP/forms/US; grep -i APP_SPECIAL.ENABLE `find . -name "*.fmb" -print`| grep 
SPECIAL7| grep -i PROPERTY_ON  
cd $AU_TOP/resource; grep -i APP_SPECIAL.ENABLE `find . -name "*.fmb" -print`| grep 
SPECIAL7| g rep -i PROPERTY_ON  
 
If you receive a result that looks like the statement below, the value is already being used. 
 
./CSCCCCRC.fmb:app_special.enable('SPECIAL7', PROPERTY_ON);  
 

Deploy a Custom Library  
Use the following steps if you have not deployed a custom Library on your Oracle Applications 
server. 
 

To deploy a custom library: 

1. Back up your existing CUSTOM.pll to CUSTOM.pll.orig. 
2. Locate the ODPNCustomPLL.zip file in the ORACLE folder where the Developer is 

installed and extract the CUSTOM.pll and ODPN.pll files. Copy them to the 
$AU_TOP/resource folder on the Oracle Applications server. 
Note: $AU_TOP is defined as a variable and references 
/oracle/VIS/apps/apps_st/appl/au in both a Unix and Windows operating system. 

3. Ensure that no one is currently using Oracle Applications (Web Forms). Shut down the 
Oracle Forms Server service if you are running 11i.   
Note: It is not necessary to shut down any service if you are running R12.  
 

4. While in the $AU_TOP/resource, compile the ODPN.pll and CUSTOM.pll library files 
using the command for your specific EBS version: 
 
Oracle 11.5.10 server: 
ifcmp60 module=ODPN.pll module_type=LIBRARY userid=apps/apps@<instance> 
compile_all=yes  
 
ifcmp60 module=CUSTOM.pll module_type=LIBRARY userid=apps/apps@<instance> 
compile_all=yes 
 
For Oracle E-Business Suite R12: 
frmcmp module=ODPN.pll module_type=library userid=apps/apps@<instance> 
compile_all=yes 
 
frmcmp module=CUSTOM.pll module_type=library userid=apps/apps@<instance> 
compile_all=yes 

Note: Replace the database connect string to reflect your instance.  
  
Note: Shutting down the Forms server is not necessary for Oracle E-Business Suite R12.  
 

Modify an Existing Custom Library  
Use the following steps if you have custom logic in your custom library (CUSTOM.pll) that you 
do not want to overwrite. You must place a line of code in the custom library that will call out 
to a new library (ODPN.pll). After doing this, you will only need to recompile your existing 
CUSTOM.pll if you receive new versions of ODPN.pll with software upgrades.  
 



 Copyright © 1998, 2010, Oracle. All rights reserved. 2-15 

To modify a custom library: 

1. Back up your existing CUSTOM.pll to CUSTOM.pll.orig. 
2. Copy the CUSTOM.pll from the $AU_TOP/resource folder on the Oracle Applications 

server to a client machine that has Oracle Forms Builder installed. 
3. Copy the APPCORE2.pll from $AU_TOP/resource folder on the Oracle Applications 

server to a client machine that has Oracle Forms Builder installed. This should be the 
same folder you used for the previous step. 

4. Locate the ODPNCustomPLL.zip file in the ORACLE folder where the Developer is 
installed and extract the ODPN.pll file. Copy it to the client machine into same folder as 
previous file copies. 

5. Open CUSTOM.pll using Oracle Forms Builder and attach ODPN.pll. Place this file in the 
same folder on the client side as your CUSTOM.pll prior to the attachment. 

6. Answer Yes, when asked to remove directory path. 
7. Add the following code to the Event procedure:  

gkod_event (event_name, 'SPECIAL7'); 
 
Note: You may use any number between 1 and 15 in the SPECIAL command as long 
as there are no conflicts. See Check Existing Custom Library Configuration for more 
details. Beginning with Oracle EBS 12.1, the SPECIAL command can be replaced with 
the MENUX command where X is a number between 1 and 15.  
 

8. Ensure that no one is currently using Oracle Applications (Web Forms). Shut down the 
Oracle Forms Server service. 

9. Copy the CUSTOM.pll and ODPN.pll files from the client to the $AU_TOP/resource folder 
on the Oracle Applications server. 

10. Compile both the ODPN.pll and the CUSTOM.pll files using steps 5 and 6 in the previous 
section. 

Modify the HELP_WEB_AGENT Profile  
You must modify the HELP_WEB_AGENT profile in Oracle to point to the oracle_gateway.html 
in the Player content deployed on the server.  
 
For Oracle E-Business Suite 11i , the URL consists of two parts: the path for the 
oracle_gateway.html file located in the \oracle\hemi folder in the Player content, plus the path 
of the default dbc file for the Oracle server.  
 
Following is an example for 11i: 
 
URL=http://<server 
name>:<port>/oracle/hemi/oracle_gateway.html?dbc=d:\oracle\o11iappl\fnd\11.5.0\secure\
<server name>.dbc  
 
Following is an example for R12: 
 
URL=http://<server name>:<port>/oracle/hemi/oracle_gateway.html  
 

To modify the HELP_WEB_AGENT profile in Oracle E-Business Suite: 

1. Sign on to the Oracle EBS Application via the web browser as an administrator. 
2. Click the System Administrator link and locate the System Profile. 
3. When the java form launches, enter APPLICATIONS_HELP% in the Profile field and 

click Find. 
4. Enter or edit the URL with the path to the oracle_gateway.html. 

Note: For Oracle 11.5.10, include the location of the .dbc file in the URL string. Once 
you have completed your changes, stop and restart the Oracle Forms service. 
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5. For the profile change to take effect in the current session, exit from the Oracle 
application and sign in again. 

6. Click Help in Oracle, and the Player launches. 

Enable Context Recognition in Oracle E-Business Suite 12.1.2  
In Oracle E-Business Suite 12.1.2, you add a profile in the System Profile form.  
  

To enable context recognition in Oracle E-Business Suite 12.1.2:  

1. Launch the Oracle E-Business Suite application. 
2. Click the System Administrator link. 
3. Click the Profile>System link to launch the System Profile form. 
4. Enter %UPK% in the Profile field.  
5. Click the Site field and change the value to Yes to enable context recognition in UPK. 

This change is available to all users in the E-Business Suite application. 
6. On the File menu, click Save. 
7. On the File menu, click Exit Oracle Applications and click OK. 

PeopleSoft Enterprise 
Set the HelpURL value inside your active Web profile configuration to point to the 
pst8_gateway.html file, located in the PST8/hemi folder in the published content.  

 
Change the value of the Help URL field in your PeopleSoft application to: 
 
http://webserver/foldername/pst8/hemi/pst8_gateway.html?ContextID=%CONTEXT_ID%&Lan
gCD=%LANG_CD% 
 
You must restart the PeopleSoft Web server service for the changes to take effect. 
 
It is a good idea to make a note of the original PeopleBooks help URL in case you want to use it 
later.  
 
Note: For further information, see the Configure Context Sensitive Help and the Enabling the 
Help Link from the Application Pages sections in the Installing PeopleBooks appendix of the 
PeopleTools installation guide.   
 
Note: It is recommended that PeopleBooks be installed before starting to record content. 
However, if PeopleBooks is not installed, the content launches directly from the PeopleSoft Help 
menu. 

SAP GUI for Windows and SAP GUI for HTML 
To integrate published help content with SAP GUI clients, you must perform the following 
steps: 

• Register an object in SAP Service Marketplace.  
  

• Copy the transport files to the SAP server.  
  

• Import the transport files into the SAP system.  
  

• Customize the SAP Help menu.  
  

• Edit ABAP code to customize the “help_start” function in SAP to launch the Player.  
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• Configure the SAP URL. This step requires configuring the URLs to point the content for 
SAP. 

For the installation, an SAP Service Marketplace user with administration rights is required. In 
the target SAP system, a user with developer rights, registered as a developer, is required. 
 

Register an Object in the SAP Service Marketplace System  
An SAP Administrator or someone who has administrative rights for the target SAP installation 
in the SAP Marketplace must perform this procedure. 
  
Register the following object: "PgmID:R3TR, Object:FUGR, ObjectName:SHL2" and make a 
note of the access key. 
 

Copy the Transport Files to the SAP Server  
The transport file contains two files, Kxxxxxx.nnn and Rxxxxxx.nnn, where x and n will vary, 
depending on the version of the Developer that the transport is from. These files must be 
copied to the SAP server. They are contained in a file called HEMITransport.zip and are located 
in the front folder in the Developer installation. 
  
Note: You will need an unzip utility such as WinZip to unzip the files. 
 

Import the Transport Files  
The transport files that you copied to the SAP server need to be imported into the SAP system. 
A Basis administrator should perform this step.  
 
All objects in this transport are located in the registered development namespace /GKOD/. This 
development namespace ensures that no naming conflicts can arise in your SAP system due to 
the transport. 
  
Note: If you want to check the import logs of the transport, select the Goto menu and then the 
Import History command. A return code 4 (Warning) and below is acceptable.  
  

Special Note for SAP Unicode-based Systems  
If your SAP System is Unicode-based, please apply the transport in the following manner via 
the command line. 

  
Verify that your instance profile has the following parameter set: abap/unicode_check=on.  
 

Apply the transport using the following procedure from the command line: 

1. Go to your \usr\sap\trans\bin directory. 
2. Type the following: 

tp addtobuffer nnnKxxxxxx <SID> 
3. Type the following: 

tp import nnnKxxxxxx <SID> -Dsetunicodeflag=true client<num> 
pf=TP_DOMAIN_<SID>.pfl 
 
Example: 
tp import D6CK900100 UC3 -Dsetunicodeflag=true client800 pf=TP_DOMAIN_UC3.pfl 

If you system is Unicode, refer to SAP Note 330267 before importing the content. 
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Customize the SAP Help Menu   

Once the transports have been imported into the SAP system, you must customize the SAP 
Help menu. Using transaction se43, customize the SAP System Help menu to launch Player 
content by creating a menu item with 'Code' ZOND and 'Functional Type' H. 

  

To customize the SAP Help menu:  

1. Using transaction se37, modify the HELP_START function module. You will need the 
access key obtained earlier. (Note: the status message...) 

2. Insert a modification above the line with statement "when 'GLOS'." 
3. Enter the modification, "include /GKOD/..." 
4. Save and activate the modification. 

Customize the HELP_START Function in SAP   
In this step, you must edit code to customize the “help_start” function in SAP. This function 
launches SAP Help menu commands and must be modified to launch the Player with special 
parameters. 
 
Note: The status message "Object FUNC_HELP_START is part of the Basis interface; further 
development not allowed" may appear. This message is not an error, and you should continue 
with the procedure.  
  

To Customize the HELP_START function:  

1. Enter *OnDemand Include. 
2. Press Enter. 
3. Type include /GKOD/Y_START_ONDEMAND. 

The space between “include” and the / in the statement above, as well as the period at the end 
of the statement, is required. 
 

Configure the Gateway URL  
In this step, you configure the help menu entry you created to point your deployed content. 
The content must be installed on a Web server to determine the correct URLs to enter into the 
system.  

  
You can set up the URL to call Player content in any client, or you can set up client-dependent 
base URLs. When you enter a Default Base URL and select the Enabled option, the entry is 
used to call Player content in any client by default. If you save the entry with the Enabled 
option deselected, the Default Base URL is not used in the system. If you do not want to use 
the Default Base URL, you must still enter an empty string in the table. If the entry is not 
defined, you will receive an error message. 
 
You can create client dependent base URLs as well. If there is no entry in the Client Dependent 
Base URL table for a specific client, the Default Base URL is used for that client. When the 
Enabled option is selected for a client, then the URL for the client is taken as the Base URL. 
When the Enabled option is deselected for a client, then Player content is deactivated in the 
client, and users will receive an error message when calling Player content. 
 
You must log in to the SAP system as a user with developer rights. Since the table you will be 
using is defined as client independent, you can log in to any client to change the entries. 
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To configure the Gateway URL:  

1. Go to transaction /n/GKOD/SS. 
2. On the Setup menu, choose Default Base URL. 
3. In the Default Base URL field, enter the path to the sap_gateway.html page in the 

content for SAP on the Web server. This must be a fully-qualified URL containing the 
sap_gateway.html page. The sap_gateway.html page is located in the front\hemi 
folder within the Player installation. 

4. Click the Enabled option to select it, if necessary. 

5. Click  Save. 

6. Click  Continue. 
7. On the Setup menu, choose Client Dependent Base URL. 
8. In the Table/View field, enter /GKOD/YEXTHLPURM if necessary. 

Translate the Help Menu  
You can translate the SAP menu items into different local languages. The Help menu will then 
appear in the language that the user specified while logging in to the SAP GUI. 

SAP Portal 
This section describes how to integrate content into the Help menu of your SAP NetWeaver 
Portal. The portal administrator or basis administrator will need to perform these steps. 

 
Because of the highly configurable nature of the SAP NetWeaver Portal, the steps that you 
must perform may be different than the steps presented here. These instructions assume the 
portal default framework is in use. If another framework is in use, or if the default framework 
has been substantially modified, these instructions may not work. 
 

 To display this content in a context-sensitive manner: 

1. Copy content gateway files to a web server in the same DNS domain as the portal. If 
the content server is in the same domain as the portal, it is not necessary to copy the 
gateway files (see Domain Relaxing.) 

2. Configure the gateway files to point to the content server. 
3. Configure the portal Help link to use the gateway files. 

Copy Content Gateway Files  
In your published content there is a front\hemi folder that contains the content gateway and 
configuration files. The contents of this folder must be placed at a location that meets the 
following requirements: 

• It is accessible by HTTP or HTTPS protocols.  
  

• It is in the same internet domain as your SAP NetWeaver Enterprise Portal server. 

For example, if the URL to access your portal is 
http://netweaverportal.mycompany.com:50000/irj/portal  
then the location where you place the gateway and configuration files may be something like:  
http://help.myco.com:50000/gateway/hemi/.  
If the content is published to a server in the same domain as the portal, it is not necessary to 
copy the gateway files to another location. 
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Domain Relaxing  
Domain relaxing is a method of enabling web-based scripting between components that the 
web browser would normally prevent due to cross-domain scripting security concerns. In some 
cases, however, this scripting enables desired functionality. Domain relaxing is designed to 
allow cross-domain scripting between components served from similar root domains (i.e. 
server1.co.com and server2.co.com). Help Menu Integration for SAP NetWeaver Enterprise 
Portal uses the same domain relaxing technique that SAP uses. Additional documentation can 
be found at: 
http://help.sap.com/saphelp_nw70/helpdata/en/28/7c383f717b5f03e10000000a114084/conte
nt.htm 
 

Configure the Portal Help Link  
The final task in setting up integrated context-sensitive Help for your SAP NetWeaver 
Enterprise Portal is to configure the portal's Help link.  
 

A user with Administration rights can perform the following steps: 

1. Log into the SAP NetWeaver Enterprise Portal. 
2. Click the Content Administration tab. 
3. In the Portal Content area, expand the Portal Content tree item. 
4. Open the Portal Users folder. 
5. Open the Standard Portal Users folder. 
6. Double-click the Default Frameworks Page to open it. 
7. Select the checkbox for the Masthead iView Page Content item. 
8. Click the Edit button. 
9. In the Property Category drop-down list select Navigation. 
10. In the URL of Help Link field, enter the URL of the sapwdp_gateway.html file. For 

example, the URL you enter may look similar to 
http://help.myco.com:50000/front/hemi/sapwdp_gateway.html. 

11. Save your changes. 

Siebel CRM (On Premise) 
Content will be launched directly from the Contents link from the Siebel Help menu. It is also 
possible to create a link to the Player in the existing Siebel Help page. 
 

To set up help integration on the Siebel web server: 

1. Go to the Siebel appication server and find the …/SWEApp/Public/ (installation) folder. 
2. Find the folder for the language of the content you recorded and locate the Help folder 

within it, then find and open the Siebhelp.css file and edit it as described in the next 
step. 

3. Add the behavior:url command to the body section as indicated below:  
body { 
margin-top: 4px; 
margin-bottom: 4px; 
font-family: Verdana, Geneva, Arial, Helvetica, sans-serif; 
font-size: 8pt; 
behavior:url(../hemi/odgateway.htc);  
-moz-binding: url(../hemi/odgateway.xml#odgateway.htc); 
} 

4. Save the Siebhelp.css file. 
5. Locate the /hemi folder under Siebel7 in the published content folder. 
6. Copy the /hemi folder and paste it in the language folder on the Siebel server. 
7. Repeat this procedure for every language you want to configure. 



 Copyright © 1998, 2010, Oracle. All rights reserved. 2-21 

Note: If you want the Contents link to open the Siebel Help page with the Player link in the 
header area, change the Show Siebel Help option in the Configuration Utility.  

Install SmartHelp for Browser-based Applications 
For browser-based applications, the SmartHelp toolbar button can be used to deploy in-
application performance support. SmartHelp can be used for context-sensitive ExactMatch or 
SmartMatch content for various target and non-target applications.  

The traditional Help Integration approach is recommended for deploying context-sensitive in-
application performance support content for a single target application as it does not require 
the SmartHelp toolbar button to be distributed to end-user desktops. However, if content is 
being deployed for multiple browser-based target applications or for non-target applications, 
then SmartHelp may be a consistent way to deliver help for all browser-based applications.  

SmartHelp is a toolbar button for Internet Explorer and Firefox browsers. Browser-based 
applications that suppress the browser's toolbar may not take advantage of the SmartHelp 
features. SmartMatch functionality for non-target applications (statistically relevant content 
items ranked in order to generate the list of applicable content items) is only available with the 
SmartHelp toolbar button. 

It is possible to configure the same SmartHelp toolbar button to deploy multiple browser-based 
target applications as well as non-targeted applications. The end users will benefit from 
ExactMatch behavior when using the SmartHelp toolbar button for target applications and 
SmartMatch behavior when using the SmartHelp toolbar button for non-targeted browser-
based applications. 

SmartHelp Installation Requirements for Internet Explorer 
The user who installs, configures, and uninstalls SmartHelp must have administrator rights to 
the local computer. Medium or medium-low security is recommended for the published 
content. In the Security tab, Local Intranet and Trusted Sites have the recommended security 
levels. For SmartHelp to work properly, the following settings should be as follows: 

• Download signed ActiveX controls: Enable or Prompt 
  

• Run ActiveX controls and plug-ins: Enable 
  

• Script ActiveX controls marked safe for scripting: Enable 

Note: If Internet Explorer and the operating system have Protected Mode support, the content 
locations and applications used with SmartHelp must have the same Internet Explorer mode, 
either Protected or Unprotected.  

Install SmartHelp for Microsoft Internet Explorer 
An ActiveX control must be installed on the end-user system to enable the SmartHelp for 
Internet Explorer. A key feature of ActiveX controls is their simple “download and execute” 
deployment model. 

 
Users can install SmartHelp by accessing the following page from Internet Explorer: 
http://<server>/<content_directory>/smarthelpsetup.html 
  
In Windows Operating systems at least Power User or higher (Administrator) privileges are 
necessary for installation. System administrators may need to modify permissions for users or 
applicable groups. It is recommended that URL for SmartHelp is part of a Internet Explorer 
security zone that is equivalent to either Low or Medium-low pre-defined settings. 
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Troubleshooting  
When the smarthelpsetup.html page displays an error, additional information is available by 
appending ?diagnosticmode to the URL. For example: 
http://<server>/<content_directory>/smarthelpsetup.html?diagnosticmode 
 
In most cases, after you restart the browser the new toolbar button will appear automatically. 
However, if the user has customized the Internet Explorer toolbar, the new button may not 
appear. In this case, the toolbar button is added to the choices in the Customize Toolbar dialog 
box, and it will appear if the toolbar is reset. For more information, see the article on the 
Microsoft Developer Network at http://msdn2.microsoft.com/en-us/library/Aa753588.aspx.   
 
Depending on the version of Internet Explorer you are using, the entire toolbar may not 
display. The SmartHelp button will be added in the dropdown list area for more buttons. 
 

Upgrade SmartHelp    
If the published content on the server is refreshed or upgraded, the new content could contain 
a newer SmartHelp version with newer resources. The SmartHelp button from the previous 
version cannot load the newer content. For SmartHelp to upgrade itself, the user must launch 
the setup.  

 
If SmartHelp does not work after a browser upgrade, the setup page can be launched to 
upgrade or reconfigure it. 
 

Uninstall from Internet Explorer  
In the System folder under the Windows folder, locate the Downloaded Program Files folder. 
Remove the HEMIIEButton class. 

See the Microsoft Windows Knowledge Base article 15485 at 
http://support.microsoft.com/kb/154850 for additional details about uninstalling and ActiveX 
component. You will need to follow the instructions to remove the HemiIEButton Class. 

Install SmartHelp for Mozilla FireFox 
An administrator needs to add the .xpi and .jar MIME types to the Web server before the 
SmartHelp button can be installed on Firefox. 

 
Users can install the toolbar button by accessing the following page from the Firefox browser: 
http://<server>/<content_directory>/smarthelpsetup.html 
 
When installation is complete, users must use the Restart Firefox button in the Add-ons dialog 
box or the button will not be configured properly. Users may then need to add the button to 
their toolbar with the Customize option. 
 
To successfully install the SmartHelp button on Firefox, the location of the deployed content 
must be added to the addon exception list. 
 

Upgrade SmartHelp  
If the published content on the server is refreshed or upgraded, the new content could contain 
a newer SmartHelp version with newer resources. The SmartHelp button from the previous 
version cannot load the newer content. For SmartHelp to upgrade itself, the user must launch 
the setup.  
 
If SmartHelp does not work after a browser upgrade, the setup page can be launched to 
upgrade or reconfigure it. 
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Uninstall from Firefox  
Please see Firefox documentation to remove the SmartHelp addon. 

Change the Name of SmartHelp 
You can change the button name, tooltip and other related messages containing SmartHelp. 
Since SmartHelp is part of the Player package, you must customize the Player publishing style. 
See Customize Publishing Styles in the Content Development manual for more information.  

Note: Changing the name of the SmartHelp button will not change existing directory structure, 
filenames, and documented references in the product.  

It s recommended that you change the name in the Library prior to publishing content and 
deploying SmartHelp. 

 

To change the name of SmartHelp: 

1. Navigate to the 
System/Publishing/Styles/<category>/Player/lang/<language>/stdhemi/hemi/smarthe
lp folder in the Library. 

2. Open the strings.resources.xml file in any text editor. 
3. Update the PRODUCTNAME value with the desired name. 
4. Save the file. 
5. Repeat for additional languages, as necessary. 
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